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BEST PRACTICES COURSE – WEEK 21 – Creating and Customizing 
Library Parts PART 7 - Custom Doors and Windows 
 

Hello, this is Eric Bobrow.  In this lesson, we'll take a look at how you can create your own custom doors 

and windows. In the last lesson, we looked at door and window panels and sashes. Now we're going to 

actually create a window from scratch. [ 0:00:16] 

Now the basic process is going to look similar at first; but then it's going to get increasingly more 

complicated.  That is why I teach the door panels and window sashes first, because creating your own 

custom windows and doors, while he gives you more flexibility does get more complex.  So let's start out 

by picking up the settings of this wall that is the frame for a window.  And I will create now a new 

window from scratch.  So I'm just going to draw a box here, let's say a certain size, 4x6. I will then pick 

up the settings for the separator and we'll just create a few separator pieces just to make them unusual 

or not part of the standard library.  [0:01:22] 

So here I have something that could be a window.  I'm going to pick up the settings of the glass which I 

have done with the slab and use the magic wand to pop it in each of these places.  And perhaps, just to 

make it a little bit different, I will take this piece of glass and color it differently so it's going to show up 

with a different color.  Now when I create this, I'm going to go and double check that it looks okay. So I 

will select these elements and then say just show what I've got selected in 3D.  [0:02:00] 

So you can see here is something that could be easily a fixed window in a wall.  I'm going to go down and 

select these first and then go to the File menu, Libraries and Objects, and say Save Selection As.  Now in 

earlier versions of ArchiCAD back a ways, you might just say "Save 3D Model As".  In later versions, you 

have to select whatever parts of the 3D window that you want to include and then Save Selection As.  

And I will say save it as a window.  [0:02:36] 

Now in ArchiCAD 16, there is a choice here that comes up that I don't believe happens in earlier versions 

and that is what is the plane of reference?  Now the horizontal plane is the default and that's how 

earlier versions of ArchiCAD would assume is that the plane at the bottom of the elements is what's 

going to be the reference for the outside of the wall.  I'll just go ahead and say Continue and Save and 

then it will be given a name. I'll just leave it as "New Window 1", and we'll have it go into the embedded 

library. But of course we could go and select the folder and place it out as a separate file.  [0:03:14] 

Now I'm saving it in ArchiCAD 16.  We have some choices for materials which will be covered in a 

separate lesson.  So let me skip over that and just say OK.  At this point, I've simply saved a new window 

and we'll go ahead and pop it into the wall. So go to the Window tool.  You can see it says "New Window 

1, it's already been loaded. Go and pop this into the wall. And let's just look at what we've got. [0:03:50] 
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So you can see that this new window did come in.  If I select it, it looks just fine here in 3D.  If I go to the 

floor plan and look closely, we will see that the symbol is not too bad. It's actually a top down view of 

the elements.  So it maybe got a little bit more detail than we might want; a few extra lines.  But for now 

let's leave that alone.  Later, we will look at how you can customize the window symbol.  If we get a little 

more complicated, for example the make something that might be a more complex shape here. I'm 

going to use the thin frame and create an L shape instead. So we will go across, let's say down a couple 

of feet, over a couple of feet, down a bit further, and line this up here.  [0:04:54] 

So now I have a frame here.  Let me take this and extend it to the other side. Take this one and extend it 

to the other side.  So now I have an L shaped piece. And just for good measure, I will go ahead and draw 

one more piece down that way.  So it's an unusual shaped window but it should work just fine.  I will 

pick up the settings again of the glass and we'll use the magic wand and pop it into each of these.  I'm 

using the magic wand and clicking, and that's creating each one of these pieces here.  [0:05:39] 

So now I'm going to select these elements, and I can do this in 2D like I was in the plan or I can go from 

the 3D window.  I'll go to the File menu, Libraries and Objects, and say Save Selection As, Window.  Now 

it's "New Window 2", and we'll just select that or go ahead and complete it. And I'm going to go ahead 

and extend this wall out so we have enough space to insert it. Switch to the Window tool and pop it in.  

Now there's a little bit of a problem when we go here to 3D. We'll see that the window, while the actual 

shape is the same as what we created, it has this gap. Because ArchiCAD is creating a rectangular cutout 

for this non-rectangular shape.  [0:06:24] 

So in order to fix that, I'm going to use a special feature that was introduced into ArchiCAD 9 and that is I 

will use the Slab tool. And before or after I draw it, I will change the ID from whatever it says to 

Wallhole.  That's all it has to be.  It can be lower case or capitals. And I will then draw this shape of the 

outline.  So basically I'm defining the outline that I would like to be cut into the wall as a hole.  Now if I 

select this, you can see that there's one slab, and that slab here is the wallhole.  It doesn't really matter 

what thickness it is or material, because it's going to be used for the special purpose of defining the 

hole.  [0:07:25] 

Now in order to define the window, I'm going to select all of this including the wallhole special piece. 

And again go to Libraries and Objects, Save Selection As, Window.  And it's ready to go.  Now let me go 

to 3D and I will select this window and switch it.  I could pop in a new one, but instead of it being New 

Window 2, I'll use one of the flick options. This will flick to the next library part that is in that same folder 

or the embedded library.  And notice that now it's New Window 3. And it's immediately got a beautiful, 

clean outline just like we would expect. It still has handles in the corners here, but the wall is clearly 

filling in nicely behind it.  So that's how simple it is to create a non-rectangular window.  You just need to 

create an extra slab that has the designation wallhole that outlines the shape that you want for the hole. 

And select that along with the other elements and save it as the window.  [0:08:29] 
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Now let's go to a project that was submitted by one of the members of the Best Practices course, 

Roderick Anderson of SARCO architects in Costa Rica.  If we go to 3D, we'll see that there is a window 

that is to be inserted in a wall like this, but when it was first created as a window, he didn't know how to 

cut a hole to shape to the right shape of the window.  And what they ended up doing as a work around 

was to draw, after drawing the basic window; they created separate little pieces to fill in the wall. Now 

there is an issue with that, because this element here - actually you're going to see some lines in some 

views between the window and the wall.  [0:09:21] 

And it has to be carefully done in the sense that the same materials and thickness of the wall have to be 

used for these pieces. So it's really not the ideal way to do it. So let's just take this and see what we need 

to do to get this window done. So I'm going to select these window elements and copy them. Then I will 

go back to the project that I was just in, and we'll paste. We'll just move this over to the side. In fact, I 

will just move it down so that it will be a little easier to see when I'm working on it.  [0:10:04] 

Now it did come in with sort of different colors here. On the floor plan, if we go to the floor plan, you'll 

notice that there's a cover fill.  If I turn off the cover fill then it becomes much easier for us to see this on 

the plan.  Now let's just go ahead and do what Roderick and his staff did earlier which was to select this 

and say Libraries and Objects, Save Selection As, Window. And we'll just name it "New Window 4". And 

we'll pop in that window and then go to 3D.  And we have the expected problem where the window is 

cutting out a rectangular hole.  [0:10:48] 

So in order to fix this, let me just go and get rid of the little marker here. I will move it off to the side. I'm 

going to go to the Slab tool and again make sure that the Slab tool is set.  In fact, I will just eyedrop the 

current one here, this outline, and then change the settings to wallhole.  So now that I've set it up with 

the wallhole designation, I am going to zoom in a little bit, use the magic wand and trace this.  So now 

you can see that, in addition to the original one, if I hit the tab key, there is the slab with the designation 

wallhole, which is the shape of the outer frame. [0:11:32] 

If I go ahead and select all of these elements here and then tell them that I'd like to save it as a window - 

actually, I want to overwrite the original window.  Let me just do this.  If I type this in and make sure it's 

the same name, it will ask me if I want to replace it.  And now if I go back to 3D, here you can see how 

this window is updated.  So it's now obviously cutting itself into the wall.  Now there are a few problems 

that I want to show you, things that you will need to refine.  You can see that this window is actually cut 

into the wall a little bit.  [0:12:18] 

The frame of the glass is in line with the face of the wall. And the actual casing of the window is on the 

wrong side.  It should be on the outside of this. I am just going to bring up the picture of it.  This is from 

the inside, and the other picture is from the outside. So you can see that there is a casing here on the 

outside but the actual cutout is just in line with the inside frame.  So let's get that going in ArchiCAD 

here.  [0:12:57] 
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So what I need to do is take this shape here, and inset it using the pet palette to inset and take it down 

to this area.  So now it's going to be just cutting a hole in the wall large enough for the inside frame. The 

other thing is that I've put in a window and I clicked down here saying this would be the outside. And yet 

you can see from the top down view of the window symbol that the frame is on the wrong side.  Now 

the convention, in terms of creating window and door parts in ArchiCAD, is that whatever is going to be 

the outside of the wall should be lower.  [0:13:43] 

And so I'm going in 3D and take an elevation here. And we'll zoom in and just get this lined up.  You can 

see the window frame here is the setup below the other elements, and it should be above. These should 

be in reverse order. Now there's no instant way to mirror this, in terms of this context, so I'm going to 

drag this up.  I will drag this and take it to the zero line of the story, which happens to be the bottom of 

the walls.  That's actually a good thing to remember is that these things work best when they are resting 

on the zero, the ground plane here.  [0:14:31] 

And I'll take these guys and move them up.  These are the interior frames, the glazing, and this is 

another piece that needs to be moved up.  So now I've got the frame and the glass all in the right 

position just above the zero line. And this piece here needs to go up next. And this one as well.  And 

then this one we'll just drag up into position.  Let's just make sure that I get it straight up and down 

there. [0:15:07] 

So at this point, if I go back to the floor plan and select these elements here and look at them in 3D, you 

can see that I've reversed it. So the glass and the frame parts are on top. And we have the larger casing. 

And there is actually a smaller casing here, which this is going to be the outside of the window.  And 

then I do have my cutout, that's the wallhole, that slab here - we're looking from underneath - is the 

wallhole.  So that's what going to actually define the hole.  [0:15:49] 

So I'm going to do this in 3D. I will select these elements here and go to File menu, Libraries and Objects, 

Save Selection As, Window.  And again it will ask us about the plane.  It only does that if you're doing it 

from the 3D view.  In this case it's critical or important, because it's going to actually use the zero.  

Remember I put the frame of the window at the zero level.  It's going to use that as the face of the wall.  

And the other things automatically will be assumed to be outside the wall.  So I'll say continue this, 

create that new window there, and we will go back to the floor plan and stretch this out a little bit 

further.  [0:16:31] 

Go to the Window tool, pop in the new window. And you can see how it automatically placed the casing 

in the right place.  Now you can see that the cutout for the wall is a little bit funny, but let's look at this 

in 3D, because what we are going to see is when I bring up the whole model, that this now is looking the 

way it should in terms of the casing.  So the frame of the window is set even with the face of the wall in 

this case; that's the way at least I've got this model.  And the casing is sitting on top of the wall and the 

hole in the wall, if we were to zoom around this and look from the other side, you can see that the hole 
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in the wall is precisely aligned with the frame here.  Unlike the earlier version, where the hole in the wall 

was out to the outside casing and the whole window was reversed.  This is much closer to what we 

want. [0:17:37] 

Now if we go back to the floor plan, we will see a major issue. One is that the symbol has totally 

cluttered with lines and the other is that the opening in the wall is too wide.  Now the reason the 

opening in the wall is too wide is that even though the wallhole was trimmed based on that one shape 

here, the symbol was created based on the full extent, going from one end to the other of the casing.  

I'm going to measure how far it is from the outside face here to the inside. And it says 5 1/8 inches.  I'm 

going to hit the D key to highlight this and copy it using Command+C or Ctrl+C. That allows me to copy 

that information. [0:18:24] 

It's just a nice convenience because what I would like to do then is open at the definition of this library 

part.  So this window, if I select it and go to the File menu under Libraries and Objects, I can say Open 

Object.  Or you can use the keyboard shortcut Command+Option+O or whatever it is on Windows: Shift 

+Ctrk+O or Alt+Ctrl+O. That will open up the definition of this particular window.  Now the thing we're 

going to look at right now is called Compatibility Options.  This may be available in earlier versions of 

ArchiCAD before 16. You may see it under Details.  [0:19:02] 

Right now parameters is separate from details; that was changed in a recent version of ArchiCAD. And 

Compatibility Options has a bunch of things that you can enter.  We are not going to be looking at all of 

them, because we don't need to know all of them.  I'm just going to point out the oversize. If you were 

doing a rectangular cut out for a window or door, we could tell it to create a little bit of extra space for 

the shim space or for inserting into the wall with the space for actual placement.  In this case, we want a 

negative space.  [0:19:38] 

I'm going to type in negative and then paste in that 5⅛ inches.  And I'll copy this here, and paste it into 

all of them, because on all four sides in this case it's symmetrical.  We need to cut the nominal hole - the 

size that ArchiCAD thinks is the hole - down.  When I do this and then save it, so I am just hitting 

Command +S or Ctrl+S, and then go back to the floor plan, we're going to see that the window hole has 

now adjusted to fit. [0:20:14] 

I basically took it in that distance, the 5 1/8 inches. And in fact if we go back to 3D and I select this, you 

will see that the size of the window has changed a little bit.  Actually from top to bottom of the frame 

it's not going out to the casing. Whereas the earlier one, if I select these two side by side, you can see 

how the handles are different.  So these handles have adjusted to match the actual casing, the opening 

of the window.  Now the symbol here is crazy.  It would just make a black mess.  So we have to clean 

that up.  [0:20:54] 
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So I'm going to open this again. I'll use the keyboard shortcut, selecting it and typing in 

Command+Option +O or Shift+Ctrl+O. And instead of going to the compatibility options, I'm going to go 

to the 2D symbol window. So the 2D symbol window shows us what this looks like.  And I'll just zoom 

this up a little bit so we have more space to work with.  And this can be edited just like any line drawing. 

So I'm going to do a quick editing here.  Just get rid of a bunch of these lines. So I could take the time to 

do a rather extensive cleanup on this, but I will just do a quick one here just to give you the point. 

[0:21:54]  

So I'll save this and go back to the floor plan. And you can see how it's now much cleaner.  I can just go 

in and clean up all those extra lines when I'm ready.  So this window now is ready to go in terms of the 

symbol.  I can make that as clean as I want. The 3D looks good. The only other thing that we need to do 

is if I open the settings here is go to the subtype.  So right now it says "Window in the Wall". And the 

parameters, while there is an extensive list of parameters here, the only ones that we will see in the 

editing environment will be the materials and pens.  [0:22:34] 

But what we want is for this to show up in a schedule properly.  Right now, for example, if I go to a 

schedule here and go to the element schedule for a window schedule, what we will see is that - and let 

me close this off to the side and make this bigger so we can look at it better - that the standard windows 

that were put in we can change parameters.  This is a standard window here.  I can type in "Special 

Order", I can type in things, but the window that is custom here, like this one, I can't actually type in 

values.  It's not giving me the blinking cursor.  [0:23:31] 

Why?  Because it doesn't have parameters for that.  So let me go and switch to that window.  You will 

see that it's set to "Window Wall".  I will go into "Select Subtype".  Window Wall does give it some 

information, but if we select "GS Window" like this, we will see under the parameters if I scroll down all 

of the listing parameters.  The ones for operation type, note, remarks, and things like that. [0:24:07] 

So I'm going to save this, having made that slight change, and then rebuild the schedule here.  And now 

you can see this part that I've created does have the ability to have the notes added.  It will basically 

show up in the schedule just like the other ones.  So this particular last window that I just changed now 

has the option to fill in the information.  So let me go back to the floor plan here.  This window now is 

showing up with a pretty clean symbol.  It is showing up in 3D properly and it's able to be scheduled.  So 

it's a little bit more complicated to do this, but you've got a nice result there.  [0:24:59] 

 

 

Now let's look at how we can create a custom door.  So we have a door panel here.  I'm going to select 

these elements and drag a copy of them down to here. Then I'll go and pick up the settings of the frame 

that I used around this window but modify it.  So I'm going to build a frame around this door.  And let's 
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say that we were going to make it as tall as a simple stud wall, a frame wall, but only as wide as a stud. 

So this is a 2x4 in American terminology here.  Now this is something that I will then draw.  Let me go 

ahead and check the material. We'll take the material and make it white here and draw this up on all 

three sides of the door that you would typically have a frame.  [0:26:05] 

And if I look at these elements here and look at that, we will see here we have a door with a frame.  

Now we could create a door just like that, what's the point?  We can obviously install this door panel in a 

regular door and be done.  Let's make this a little fancier, something that we couldn't do if it was just a 

door panel. So what I am going to do is create a casing for it that has a profile shape, a casing molding 

profile.  I could draw it from scratch, but I'm going to go into the Object tool and I'll search.  [0:26:47] 

I know there are some nice molding profiles in the U.S. library in the general section under the Detailer 

library and under wood casings.  Let's say I will pick one of these casings here.  We can go and select 

different ones.  I will pick this one and say OK and drop it into position.  I'm going to simply use it as a 

reference for creating a fill.  So I will go to the Fill tool here and then set up to create a fill. It's going to 

have an empty fill here and I'm going to magic wand and trace that. In order to trace it, I need to 

explode this symbol. [0:27:43] 

So this is a symbol, an object. I will go to the Edit menu, Reshape, Explode into Current View. And just 

keep the drawing primitive.  So this will leave us with lines like this, but there's also some other lines and 

curves that are in the middle of it which I don't really want, so I'm going to simply use the magic wand 

with the fill and trace it.  So now there's a fill.  I will just drag this off to the side so we can see it's 

separate. [0:28:14] 

Now having done that, I'm going to go to copy this, because I'd like to use this as a casing for the wall or 

for the frame around the door.  I'm going to use a little trick here.  I'm going to select the wall frame 

here that I used for the actual jamb of the door. And I'm going to right click and say Capture Profile of 

Selection. So what this will do is copy the basic shape which in this case is just a simple rectangle into 

the Custom Profile, Profile Editor.  And now I'll go and paste in the shape that I wanted like this.  

[0:29:01] 

And this shape, if I wanted it to have a little more definition I would drag it off to the side say ¼ inch.  So 

this now sticks out - how much? We will measure it from this point to here. This is 1¼ inches.  So this is 

now a casing on one side.  I will mirror a copy to the other side.  So now this is going to be a combined 

shape that will be the jamb plus casing.  So I am putting this altogether.  These two elements here, these 

fills, I need to make sure that the material in 3D when we see it is set up properly, because when I 

pasted it in a just used the default material.  [0:30:00] 

So I'll go ahead in the profile manager and set those up for the white paint here.  So now we have 

something that I can store as a profile. And you can see how I see as soon as I click store it records the 
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information here.  And let's just call this "Door Casing".  So I've now got something that is a door casing, 

it's set up to be used with the Wall tool. So that means when I go back to the floor plan I can select these 

walls and switch them from straight up and down walls to a profiled wall and then select that door 

casing. And you can see how instantly they changed in shape on the plan. And if I select these and go to 

3D you can see now we've got something much more elaborate for the door.  [0:30:55] 

So now we are creating a custom door that has a custom panel and an actual casing with the molding 

profile, which you can't do with the standard ArchiCAD library parts unfortunately.  So having done that, 

let's select these and then go to the File menu, Libraries and Objects, Save Selection As, Door.  And the 

horizontal plane, which is offered in ArchiCAD 16, is going to be the zero. Essentially the slab was sitting 

on the zero. So that means that the casing part, as it extends down below the zero, is going to stick 

outside of the walls.  [0:31:36] 

I will continue and save this. Then go back to the floor plan and pop this into the wall.  Now we do have 

a little bit of a problem in that the door was created with a jamb that was the only set for a specific 

distance or the size of the framing.  So it's not going out to the other side. If you think about it, this 

frame here, the wall is being cut too far just the same way we had with the original window. But let's 

take a look at this in 3D and see what we’ve got. [0:32:25] 

We now have a door with a casing. So let's clean up the issues that we have. First of all, I would probably 

want to create a door. If I needed to do this, I would want to create the door with the framing to the 

right size for the wall. That's a little bit awkward, because we are going to want to insert this door into 

different walls at different times. That's one of the reasons why working with existing doors is often a lot 

smarter, just because we don't have the flexibility to put in a molding thing, but we don't have to worry 

about creating different versions for different wall thicknesses. [0:33:04] 

So it's a bit of a tradeoff. If you're really clever with GDL scripting, you can make this parametric, but I'm 

not going to teach that today. That would be the subject of a whole separate course on GDL scripting. 

But we will look at some of the basic corrections. For example, if I do make the wall the same thickness 

that I had designed the frame for. So I will just draw this wall here and then go to the door and pop it in. 

You can see how that does fit better. Let me get rid of the one back here. [0:33:45] 

And now I'm going to select this and again use the File, Libraries and Objects, Open Object. Or you can 

use the keyboard shortcut for that. And I will go into the compatibility options. Now remember, I made 

the casing 1¼ inches, but I have to subtract that. so I am going to put minus. Then I will put that in on 

the sides but not the bottom. I will save this and now, on the floor plan you can see - actually, the 

symbol was updated. [0:34:19] 

If I go back to the floor plan you can see how it was also updated so that it now is fitting in. the actual 

symbol I would want to clean up, because that is a whole lot of lines there. So again, I can do that, just 
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go in here to the 2D symbol and clean that up. And let me quickly clean that up. It’s a little simpler, 

maybe doing the same thing on the other side. So it could be cleaned up a little further, but let's go on. I 

will save this and go back to the floor plan. And you can see now I have the door fitting in here. But oh, 

what about the door swing? [0:35:20] 

So instead of doing just cleanup we will go ahead and draft in something new. So I will take this here. 

Now the convention when you are working with a door in the ArchiCAD library, you are creating a whole 

new door, is that the door should be set to swing to the upper right. So while you could in theory draw it 

in any direction, that is the one that ArchiCAD will use. So if you install it, say the door swings in a certain 

direction, if you do it this way, it will match that. [0:35:57] 

So I am going to draw a line from here. I wanted to draw it up, but I want it to be the same size as the 

actual door. So I am going to use a little trick here. I am going to go over to the other side, get it as if I 

was going to draw the line straight here, then use the tab key a couple of times to highlight the angle 

and type in 90. And now having done that, I have a line of exactly the right size for the leaf. I will drag a 

copy of the leaf over say 1½ inches or whatever that should be, and the also draw an arc. [0:36:37] 

So snap this here. So if I save this and go back to the floor plan, you will see that this door now has the 

proper swing. Often we would have a hotspot here to select it. So if I go back to the door here, to the 2D 

symbol, I could use the hotspot tool here and put that in, save it, and go - actually, let's also go in this 

door and bring up the name in the door controls. Go to the subtype. And again, now it says "Door Wall". 

I would need to set it up for "GS Door" or whatever doors match in the library that you are working with. 

[0:37:22] 

If I say select and save now, when I go back to the floor plan, not only do we have a symbol that works 

but of course this looks good in 3D. we are also going to see that this particular instance, like the other 

ones, we go up to the parameters here, we will have all these parameters that are available, including 

the ones that would go into the schedule such as notes and remarks. And that has been created because 

I changed the subtype. [0:37:57] 

So this concludes our lesson on creating custom windows and doors. It's a little complicated, but 

hopefully I explained it well enough for you. This has been Eric Bobrow. I look forward to getting your 

comments and questions on the page down below. Thanks for watching.  

[END OF AUDIO 0:38:17]  


